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Chapter 1

Introduction

Overview

The ATEN Control System is an Ethernet-based management system that 

incorporates ATEN controllers (ATEN Control Box and/or ATEN Control 

Pad) and control interfaces (ATEN Keypads and ATEN Touch Panel) for 

connection, configuration, and operation of all hardware devices in a room or 

large facility to provide convenient control effortlessly via a mobile device or 

an ATEN Touch Panel. The ATEN controller works as the main controller that 

provides connectivity to hardware devices commonly seen in settings such as 

meeting rooms, conferences, boardrooms, and classrooms. 

After connecting the hardware, the ATEN Configurator (VK6000) provides 

simple setup of the devices with easy step-by-step configuration. The ATEN 

Touch Panel and ATEN Control System app, for iOS, Android or Windows 

mobile devices, then empowers you with the mobility to control all hardware 

devices remotely, whenever and however you like.

ATEN Control Box/Control Pad can be easily deployed into an existing 

installation and integrate seamlessly with ATEN VanCryst pro-AV products 

and nearly any other hardware devices found in a room, including AV 

equipment, lighting, conference systems, air conditioning, motion sensors, 

power switches and many more. The controller serves as the central platform 

where hardware devices are connected — to be monitored, managed, and 

controlled directly via a tailor-made GUI — a Viewer — from any iOS, 

Android, or Windows mobile device or an ATEN Touch Panel.

The control system project and its control interface is configured using an 

intuitive program — the ATEN Configurator (VK6000). The ATEN 

Configurator walks you through configuring the hardware, designing the 

control interface (Viewer), and uploading this configuration to the controller.  

Through an Ethernet connection, the ATEN Control System app enables you 

to edit and download Viewers from the controller via a point-n-tap user 

interface. The use of each Viewer is protected with password authentication to 

ensure secure access.
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2. Verify the selected controller and viewer and configure the selection if 

required. 

 Controller highlighted black: This is the controller that is found in the 

network and its ID matches the one you specified in this project file. 

The viewers created for the controller are listed below this item.

 Controller highlighted gray: This is the controller that also exists in the 

network, but does not match the controller ID specified in this project 

file.

3. Optionally click on the following to configure password authentication 

settings.

Note: Due to security concerns, the access key of any ATEN controller 
will need to be modified at least once before the controller can be 
accessed for any of its functions. If you have not modified the access 
key, the upload will not be performed. To resolve this issue, log in 
to the controller’s web interface and follow the on-screen prompt to 
modify the access key.

 Edit Access Key: Click to edit the access key you entered for 

uploading Viewers to the controller and download Viewers from a 

mobile device. 
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 Note: A valid access key should only contain upper-case alphabets, 

lower-case alphabets, and/or numerals. : An access key is required 

to upload Viewers to the controller and download Viewers from a 

mobile device.

 : An access key is not required to upload Viewers to the 

controller and download Viewers from a mobile device.

  : The access key has been changed on the controller’s web 

interface (Dashboard). To change the lock status, click on the icon and 

type the new access key to proceed.

4. Click Upload to Controller.

Note: By default, the project file is uploaded along with your selected 
Viewers. To only upload the selected Viewers, click Also upload 
project file to disable the function.

Viewing Controller Information

Click  to view the controller’s information.

 IP Address: Displays the IP address. 

 MAC Address: Displays the MAC address.

 License: Displays the number of licenses available and in use. 

 Select License: Allows you to load a new license file.

 Reset License: Resets all license(s) in use by mobile devices. This will 

disconnect all mobile device connections to the controller.

 Firmware Version: Displays the firmware version.

 Capacity: Displays the amount of space available for uploading Viewers.

 Viewers: Lists the Viewers currently stored on the controller.

 Remove Viewer: Click the trash can icon to remove the Viewer stored 

on the controller. 

 Project: Lists the project file currently stored in the controller.
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Chapter 5

ATEN Database Generator

Overview

The ATEN Database Generator is a repository that allows you to establish and 

store commands for operating devices managed by ATEN Control System, and 

reuse them when configuring Viewers. 

Accessing the Database Generator

In ATEN Configurator, goto Tools > Database Generator. The following 

window appears with the Add Device to My Library dialog box opened if you 

are accessing the Database Generator for the first time.
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Menu Description

Add New Device Configure a custom hardware device to add to My Library. 

Add Device from 
ATEN Device Library

Add devices from the ATEN Device Library to My Library. 

Add Device from 
Driver File

Add devices from a database file (*.vkd) to My Library. 

Check Box Click Do not show this dialog again to prevent the dialog from 
appearing when the Database Generator is opened. Use the 
Preferences menu option to bring the dialog window back. 

Close Click the Close button to exit the dialog window. 

Add New Device Configure a custom hardware device to add to My Library. 
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My Library

My Library allows you to create custom hardware devices which can be 

selected to configure ports on the controller. My Library lists all the hardware 

devices that you have created, added, and edited using the Database Generator. 

You can create new hardware devices or add existing devices from the ATEN 

Device Library (page 266). These devices can then be selected from My 

Device Library for use. 
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Function Tabs

More functions can be accessed from the function tabs toward the top of the 

My Library window. Refer to the table below for information about each 

function.

Tab Description

File The File menu provides options to:

 Add New Device: Configure a custom hardware device 

to add to Device Library.

 Add Device from ATEN Device Library: Add devices 

from the ATEN Device Library to My Library.

 Add Device from Driver File: Add devices from a data-

base file (*.vkd) to My Library.

 Export My Library: Saves My Library as a database file 

(*.vkd) that can be imported later.

 Export Selected Device: Saves the selected device(s) 

as a database file (*.vkd) that can be imported later. 

 Controller Connection: Searches for a controller to 

test the connection or run the learning mode for the IR 

port.

 Quit: Exits the program. 
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Edit The Edit menu provides options to:

 Delete: Deletes the selected devices from the data-

base. 

 Duplicate: Makes a copy of the selected device(s) and 

adds them to the library with the extension “-Copy”

 Preferences: Provides options to:

 Set the Language 

 Show Add Device dialog on startup 

 Show IR Learning tips

 Set the IR Learning Timeout - how long to attempt a 

connection to an IR device before IR learning stops.

Library Provides a list of the Libraries that you can open to select 

devices from and edit or add to My Library. The libraries 

that are listed here appear when you select a database 

using Add Device from Driver File.

Help Provides support and software version information. 

Tab Description
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Controls on the My Library Window

You can add new devices by creating a new device, duplicating an existing 

device, selecting a device from the ATEN Library or importing a driver file. 

Use the check boxes to select individual devices or All to select the entire list.

Click to add a new custom device to the database.

Select a device and click this icon to create a duplicate.

Click to add and edit a device from the ATEN Device Library.

Click to add a device from the driver file.

 Select a device and click Edit to change the settings.

 Key in word strings then click Search to find a device.
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 Click All, Serial, IR, DO, Relay or Ethernet to filter the list by type. 

 Click Brand, Category, Model, Type or Version to sort the devices.

 Click Export Selected Device to save the selected devices. 

 Click Delete Selected Devices to remove the selected devices. 
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Editing / Adding a New Device

To edit or add a device to My Library, do the following:

1. From the menu select File → Add New Device, or select a device from My 

Library and click Edit.

2. Under General, use the drop-down menus or type in the Brand Name, 

Category, Model and Version. 

Note: The Category determines what buttons are auto generated when a 

Viewer page is created for the device. 

3. Use the History button to open the Version History editor and make notes 

about the updates being made to the device configuration. You can create 

and use different versions of the same device and track the changes. The 

version history can be viewed and different versions selected from the 

ATEN Configurator, under device Properties. 

4. Check the hardware type and configure the device. ATEN database 

generator supports serial, IR, digital output, relay, and Ethernet devices. 

For more information about configuring each of these device type devices, 

refer to the following sections.

 Serial: See Serial Device, page 249.

 IR: See IR Device, page 253.

 Digital output: See Digital Output Device, page 255.

 Relay: See Relay Device, page 256.

 Ethernet: See Ethernet Device, page 257.
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Serial Device

 Click to add an Action. 

 Click to create a duplicate of the Action.

 Click to delete the selected action. 

 Click to enter a string within () which allows the text to be edited 

from the VK6000 in the Button Action - Commands list (see page 160).

 Click to add a drop menu into a Command string, then enter the 

number sequence in the brackets []. The Function name must include 

an asterisk (*) for each drop menu in the Command string.The drop-

down menu will appear where the (*) is entered in the Function name. 

 Click to add an Enter into the Command string.
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Right-click one or more serial commands to copy and paste them as 

Ethernet commands of all protocols (except HTTP/HTTPS):

 Settings – Use the drop-down menus to set the: Baud Rate, Data Bit, Stop 

Bit, Parity, Flow Control and Mode settings. 

 Listen – Use this function to create a list of device parameters that you 

want the controller to monitor by receiving notifications on setting or 

status changes of the specified parameters. 

Note: To set up queries for the status of a device parameter, go to the 

Function List and click  to add the querying action as a command.

 Advanced

 Delay Interval – Sets a time delay for each command before they 

are sent to the device. 

 Feedback Timeout – Sets the maximum interval that the 

controller allows in between parts of a feedback message. If the 

controller has not received any feedback for longer than the 

specified Feedback Timeout, the controller identifies the last bit 

of the received information as the end of a feedback message.

 Receive Duration – Sets the allowed duration of time for the 

serial device to receive a complete message from the controller.

 Checksum Type – To have the checksum automatically 

calculated and filled in by the controller, select Modbus for this 

setting.

 Keep Connection Alive – Specify an interval that the controller 

waits before sending the specified command to test if the 

connection to the serial device is up or down.

 Function List – Use this section to configure the device functions by 

adding actions to the list. 
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 String Format – Use the buttons to select HEX or ASCII. To use HEX 

strings with ASCII one, select ASCII and type \x before typing the 

HEX strings. 

Note: HEX strings are also supported under the ASCII format.

 Function – Lists the actions created for a device. A Function name 

must include an asterisk (*) if you are adding a drop menu to the 

Command string. Double-click to edit the function name. 

 Command – Shows the command string created for the action. 

Double-click to edit the string.

 Message – The Message column is used to create and store feedback 

and/or queries for the corresponding command. 

 For more information about adding feedback, see Testing 

Commands, page 262.

 For more information about creating queries, see Configuring 

Queries, page 264. 

 Click Send to connect to a controller and test the typed command. 
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 Click to select a controller from the list. Use the Refresh button to 

refresh the list. To browse for controllers in the LAN, click the 

Intelligent Search button or type the IP address of the controller.

 Click OK to proceed to test the command. For details, see Testing 

Commands, page 262.

Text Command Tools

The following formats allow you to enter command strings with text that 

provide special features. These formats work in Serial and Ethernet commands. 

 ()  entering text in () allows the command to be edited in the VK6000. 

Example: (A1 A9) (A8 B6) – this command string will provide two 

editable text boxes from the VK6000 in the Button Action - Commands list 

which allow you to change the command string:

 =  using the equals sign before a text command allows you to type in 
words which will show up in a drop-down menu to describe the command, 

rather than show the text command itself. 

Example: [Power On=0A,Power Off=0B,Standby Mode=0C] – this 

command string will provide a drop-down menu with three choices using 

the text before the equal signs to describe each command – from the 

VK6000 in the Button Action - Commands list:

 ““  quotation marks allow three symbols (, = @) to be added to a 
command that uses the equal sign as described in the example above. 

Three symbols not allowed within the quotation marks include (“” () []). 

Quotation marks can be used to the left of = in a HEX command; on either 

side of = in an ASCII command; and anywhere in an Ethernet command.

HEX Example: [“Power=On”=0A,”POWER=Off”=0B]

ASCII Example: [“Power=On”=pwn,”POWER=Off”=pwf]
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In the HEX example, “Power=On” allows the equal sign to be inserted 

before =0A. If the quotes are removed, the command Power=On=0A 

would fail as an Invalid String.

IR Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected action. 

 Settings – Use the drop-down menu to set the Repeat setting (number of 

times a signal is sent): 1 Time, 2 Times or 3 Times (Default). 

 Advanced 

 Delay Interval – Sets a time delay for each command before they 

are sent to the IR device. 

 Receive Duration – Sets the allowed duration of time for the IR 

device to receive a complete message from the controller.

 Function List – Use this section to configure the IR functions by adding 

actions to the list. 

 Click  to add an action. In the pop-up dialog box: 

 Auto Learn: Select this option to add the action through learning,
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 Manual Input: Select this option to add the action using Pronto 

hex codes. Double-click the command to enter the Pronto code for 

the device.

Note: To obtain Pronto codes for a control system managed, third-

party device, search Internet forums or the manufacturer’s product 

web pages.

 Quick Mode – Click to run Learning Mode for all IR actions in the 

Function List. When the Quick Mode window opens, click Start, a 

pop-up window appears to select a controller. Check a box to select a 

controller and click Select. Click Start a second time to run Quick 

Mode using the Learn instructions below. 

 Function – Lists the actions created for a device. Double-click to edit 

the Function the name. 

 Status – Reports the status (Tested, Failed, Learned) of the Learn and 

Test buttons. 

 Learn – Use to transfer commands from an IR remote to the Control 

Box. Click Learn. The Select Controller window appears. 

 Click to select a controller from the list. Use the Refresh button to 

refresh the list. To browse for controllers in the LAN, click the 

Intelligent Search button or type the IP address of the controller.

 Click Learn a second time to start learning mode. When the IR 

Learn LED flashes green, point the IR remote at the Control 

Box’s front panel IR Receiver and push a button on the remote. 

Press the button on the remote just as you would when using it 

with the hardware device. If the device responds to a long hold or 

quick tap of the remote’s button then you must press the button in 

the same manor (long hold or quick tap) when it using for 

Learning mode. The Control Box will beep and the Learn LED 

will light solid (then turn off) when IR learning is successful. The 

LED also turns off if Learning mode times out.
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 Test – Use to test if commands are sent successfully to the Control Box 

and hardware device. 

 Click Test, a pop-up window appears to select a controller and the 

IR port. Check a box to choose a controller and use the drop-down 

menu to select the IR port and then click Select. 

 Click Test a second time to test if the IR data transmits 

successfully to the Control Box. Check the hardware device to 

confirm that it responded appropriately. 

 The Status column reports the Learn and Test results.

Digital Output Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

 Advanced – Click to use the Delay Interval drop-down menu to set a 

timed delay for each command before it is sent to the device.

 Function List – Use this section to configure the Digital Output device 

functions by adding actions to the list.

 Function – Lists the actions created for a device. Double-click to edit 

the Function name. 

 Command – Shows the command selected for the action. Click the 

drop-down menu to select an action (Open, Close, Toggle, Pulse).
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Relay Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

 Advanced – Click to use the Delay Interval drop-down menu to set a 

timed delay for each command before it is sent to the device.

 Function List – Use this section to configure the Relay device functions 

by adding actions to the list.

 Function – Lists the actions created for a device. Double-click to edit 

the Function name. 

 Command – Shows the command selected for the action. Click the 

drop-down menu to select an action (Open, Close, Toggle, Pulse).
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Ethernet Device

 Click to add an Action.

 Click to create a duplicate of the Action.

 Click to delete the selected action.

 Click to enter a string within () which allows the text to be edited 

from the VK6000 in the Button Action - Commands list (see page 160).

 Click to add a drop menu into a Command string, then enter the 

number sequence in the brackets []. The Function name must include 

an asterisk (*) for each drop menu in the Command string. 

 Click to add an Enter into the Command string.

Right-click one or more Ethernet commands (except HTTP/HTTPS) to 

copy and paste them as serial commands:

For special command string tools, see Text Command Tools, page 252.
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 Settings

 Protocol – Click the drop-down list to select a protocol for the device

 Port – Type the port number for the device.

 Advanced – Click to configure the following settings. The supported 

settings may vary depending on the device protocol and authentication 

type.

Delay Interval Sets a time delay for each command before they are sent to 

the device.

Delay Time after 

Login

Sets a time interval that the controller waits to request for 

login credentials of a device after establishing connection with 

the device.

Receive Duration Sets the allowed duration of time for the Ethernet device to 

receive a complete message from the controller.

Send command 

after successful 

connection

Enter a First and Second Command to send to the device 

after a successful connection has been established. 

Auth Type Sets the authentication type for the device.

Timeout Specifies the maximum time that the device allows for 

receiving each feedback message from the device before 

timing out.

URI path Type the part of the WebSocket URI that follows its

communication port. For example, if the URI is
wss://<host>:31416/Dicentis/API, type /Dicentis/API in this 

field.

Sub-protocol Type the subprotocol for the Ethernet device. This

information shall be available in the device’s reference or user 

manual.

ExHeader Type the required data for handshake header.

Extension Type the required data for the Sec-WebSocket-

Extensions header field.

Login Command Sets the command for logging in to the device.
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Parameter Sets the parameters (keys) of the device that are required for 

the controller to connect to the device. For example, the 

device username and password are required when 

connecting to the device, and the valid values are admin and 

123456 respectively. 

Keep Connection 

Alive

Specify an interval during which the controller sends the 

specified command to make sure the it is connected to the 

Ethernet device.

Automatically 

reconnect if no 

return message is 

received 

Check this box if you want to continue reconnection attempts 

when no return message is received from the device.

WSS Select to encrypt the WebSocket connection.

Use Default Click this button to restore to default settings. 
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 Function List – Use this section to configure the device functions by 

adding actions to the list. 

 String Format – Use the buttons to select HEX or ASCII. (TCP only)

 Function – Lists the actions created for a device. A Function name 

must include an asterisk (*) for each drop menu you add to the 

Command string. Double-click to edit the function name. The drop-

down menu will appear where the (*) is entered in the Function name

 Command – Shows the command string created for the action.

 To edit a command for a Telnet, PJLINK, ONVIF, or TCP 

compliant device, double-click the Command field (green area in 

the interface).

 To edit a command for an HTTP or HTTPS compliant device, 

click the Edit button. The Edit HTTP Command window appears.

 Feedback – Stores return messages generated by testing the command 

strings. Double-click to manually add or remove stored messages. This 

function is not applicable for ONVIF devices.

 Send – Click this button to test the command for the function. The 

return messages can be saved to Feedback. 
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This screen appears when Send is clicked. Select a controller for the 

device to connect and configure the fields such as device IP address. 

Intelligent Search Click to locate controller without specifying an IP 

address.This option only searches for controllers on the 

same local area network. For controllers across a 

network device, such as a router or switch, you must 

specify the IP address. 

Search by IP address Enter the IP address and click Search to locate a 

controller.

Controller ID Use the check box to select the Controller, fill in the IP 

Address, Username and/or Password and then click 

OK. Next use the instructions below this table. 

Refresh Click this button to refresh the Controller ID list.

IP Address Type the IP address of the device.

Username Type the device’s username.

Password Type the device’s password to grant access right to the 

controller.

Receive message for Specifies the maximum allowed time that the device 

receives messages from the selected controller.



ATEN Control System User Manual

262

Note: The username and password are not required for UDP and TCP 

devices, and the username is not required for PJLINK devices.

Testing Commands

After selecting a controller for the device and configure the required settings 

(if any) in the select controller window, click OK to proceed to test the typed 

command. The Test Command window appears. 
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Select which device to send command to by choosing Send to all or Send to 

specific and then click Send Test Command. This window appears.

The test results will appear in the yellow area of the window and the feedback 

messages listed in the Feedback column.

 Add – Click to save a feedback message in the Saved Feedback message 

window.

 Pause / Continue – Click to pause sending/receiving the command/return 

message. 

 Save & Exit – Save the feedback messages to the list and close the 

window.
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Configuring Queries

You can set up queries to actively monitor parameters of a serial or Ethernet 

device and store the obtained value into a variable for reuse in a control system 

project. 

Take the example of querying the cumulative number of hours that a projector 

lamp has been used to be able to estimate the remaining lifespan and plan for 

replacement in advance. 

1. In Database Generator, click Edit to enter the settings page for the 

projector.

2. Add a command by clicking  and double-click the command column to 

type the command of requesting for the cumulative lamp usage (hour). 

Consult the user manual for the device to find out the operation command.

3. Set up a variable to store the queried value.

a) In the Message column, click Edit. The Edit Messages window 

appears.

b) Click the Script tab and click +Add Script and name the script. 
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c) Write up a script to create a variable that stores the requested value, in 

this case, the cumulative lamp hour.

d) Click Save.
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ATEN Library

The ATEN Library can be accessed from the project bar and provides the 

complete list of hardware devices available in the database. The You can add 

any device in the ATEN Library to My Library. Once a device is added to My 

Library, the device settings can be edited as needed. 

 Use the check boxes to select devices to add to My Library. Check All to 

select all devices in the list. 

 Key in word strings then click Search to find a device.

 Click All, Serial, DO, IR, Relay or Ethernet to filter the device list by 

type. 

 Click Brand, Category, Model, Type or Version to sort the devices.

 Click Add to My Library to add the selected devices to My Library. 

 Click Cancel to return to My Library.
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Chapter 6

Remote PC Control

Overview

While being capable of controlling serial, IR, I/O, and relay equipment, ATEN 

controllers also support remote control of computers This control is achieved 

with a program, ControlAssist, that grants control right to a specified ATEN 

controller via the network. When a computer is installed with ControlAssist, 

you can remotely perform the following:

 Control PowerPoint slides

 Control media files through Windows Media Player

 Initiate actions on third-party programs using hotkeys that have been 

defined for the programs

 Perform system control such as shutting down the computer, execute 

command prompt, set system volume, and run a program

Note: For a full list of supported actions, see Supported PC Control Actions, 

page 278. 

Specifications

 Supported computers

 Only Windows-based computers are supported for remote control.

 Each computer is deemed as an Ethernet device to the ATEN 

controller, and therefore follows the specification that each controller 

can support up to 25 Ethernet devices.

 To use ATEN Viewers on a Windows platform, make sure to install 

Internet Explorer version 11 or later.

 PowerPoint File Control

 ControlAssist only supports PowerPoint files that contain 200 slides or 

less, and are created using Microsoft Office 2007/2010/2013, or WPS 

Office.

 ControlAssist only supports the following PowerPoint file formats: 

pps, ppt, and pptx.
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 Media File Control

 ControlAssist only supports media files created using Windows Media 

Player.

 When a media file is remotely enabled and controlled using an ATEN 

Viewer, the file opens in Windows Media Player and this setting can 

not be changed.

 If you encounter any issues playing a media file, try install a third-

party video codec.

 ControlAssist only supports control of the following media file 

formats: 

Category File Formats

Windows Media format asf, wma, wmv, wm

Windows Media Metafiles asx, was, wvx, wmx, wpl

Microsoft Digital Video Recording dvr-ms

Windows Media Download Package wmd

Audio Visual Interleave avi

Moving Pictures Experts Group mpg, mpeg, m1v, mp2, mpa, mpe, m3u

Musical Instrument Digital Interface mid, midi, rmi

Audio Interchange File Format aif, aifc, aiff

Sun Microsystems and NeXT au, snd

Audio for Windows wav

CD Audio Track cda

Indeo Video Technology ivf

Windows Media Player Skins wmz, wms

QuickTime movie file mov

MP4 audio file m4a

MP4 video file mp4, m4v, mp4v, 3g2, 3pg2, 3gp, 3gpp

Windows audio file aac, adt, adts
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Setting Up Remote PC Control

Follow the steps below to install the required programs on the target 

computers, configure the associated controller, and customize the Viewer for 

remote PC control.

1. Make sure you have installed Microsoft Visual C++ Redistributable for 

Visual Studio 2015 to the target computer. To download the package, go to 

https://www.microsoft.com/en-us/download/details.aspx?id=48145

2. Install ControlAssist on the computer you wish to control. For detailed 

steps, see Installing ControlAssist on Target Computers, page 269.

3. Add the computer into the control system. For detailed steps, see Adding 

Target Computers to the Control System, page 272.

4. Create a control interface to be used on a licensed mobile device. 

 For detailed steps, see Configuring a Control Interface, page 274.

 For details on licenses, see Licenses for Mobile Control, page 77.

Installing ControlAssist on Target Computers

Follow the steps below to install ControlAssist on the computers you wish to 

control. 

1. Download ControlAssist.

a) Visit the ATEN download page:

https://www.aten.com/global/en/products/professional-audiovideo/

control-system/controlassist/

b) Search for “VK6000”. A list of downloads for VK6000 appears.

c) Click ControlAssist_Vx.x.xxx.zip to download.

2. From the downloaded file, double-click ControlAssist_Setup to install 

the program. An installation wizard appears.

3. Follow the on-screen instruction to complete the installation. 

4. When the installation is complete, ControlAssist  runs in the system 
tray.

Note: Keep the ControlAssist program enabled in the system tray to allow 

the controller to establish connection with the computer.

https://www.microsoft.com/en-us/download/details.aspx?id=48145
http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/


ATEN Control System User Manual

270

5. To configure ControlAssist, right-click  in the system tray and select 

Settings. This window appears.

Click the Basic Settings, Certification & Private Key, or About ATEN 

ControlAssist to access the following settings/information.

Control Default Description

Basic Settings

The settings with which an ATEN controller needs to establish connection with the 

computer and to gain control right.

Username admin The credentials required for an ATEN 

controller to establish connection with the 

computer. 

Note: To change the username and 

password, make sure to log in the computer 

using an Administrator account.

Password password

Port 6277 The port through which ATEN Configurator 

establishes connection with the 

ControlAssist-installed computer.

Session timeout 3600 The maximal time allowed for the controller to 

establish connection with ControlAssist.

Root Folder N/A This field specifies the computer path under 

which files are display in the PowerPoint 

Control and Media templates’ file list. To 

display files at the computer’s partition level, 

type %MY_COMPUTER% in this field.
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Note: If the text in the ControlAssist window appears oversized, change 

the desktop font size to its default, and then log in the computer 

again to resolve the issue.

Upload SSL Certificate and Private Key

Upload an SSL certificate and its private key to secure sessions between the 

computer and the connected controller.

Certificate Default 

certificate

Click Choose a file from... to browse for an 

SSL certificate.

Private key Default 

private key

Click Choose a file from... to browse for a 

private key SSL certificate.

About ATEN ControlAssist

Version N/A Indicates the release version. 

Visit Official Website N/A Click to open the official website for more 

information.

Control Default Description
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Adding Target Computers to the Control System

After you have installed ControlAssist on the computers you wish to control, 

follow the steps below to establish connection between the controller and the 

target computers.

1. From ATEN Configurator, locate and open your project file.

2. Click the Device tab, and from the Ethernet device type category, click on 

a blank device or click Add More Devices to add one.

3. Click Library. This window appears.
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4. Use the search box to search for “controlassist” to load the ControlAssist 

database. This screen appears.

5. Click Add to Project. This computer, identified as an Ethernet device 

installed with ControlAssist, appears in the Device Configuration List.

6. Select the newly added device and configure the Properties settings on the 

right of the interface.

Hint: If you have more than one computers installed with ControlAssist, 

change the device name to distinguish these PCs.

For details on Properties settings, see Ethernet Device Properties, 

page 113.
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Configuring a Control Interface

Example 1:

Follow the steps below to create a control interface that allows you to browse 

and play any file from the specified root folder (see page 269) in the target 

computer. You can follow the same logic for creating a media control page.

1. In the Design tab, make sure your home page contains a presentation 

button and the Viewer contains a PowerPoint page. 

2. Configure the button to have it link to the PowerPoint page if pressed in 

the Viewer.

a) Click the presentation button.

b) Select Link and then double-click the PowerPoint page.
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3. Configure the PowerPoint page if you did not use a built-in Viewer 

template. 

a) In the left sidebar, click PowerPoint.

b) In the PowerPoint page, right-click any blank spot and select 

PowerPoint Control Template. A pre-made screen is added.

c) In the Properties column, use the Select Device drop-down menu to 

select the PC that stores the PowerPoint files you want to play.
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Example 2: 

Follow the steps below to create a quick access button for opening and playing 

a specific PowerPoint file. You can follow the same logic to create a button for 

opening and playing a specific media file. 

1. Create an outlook for the interface.

a) In ATEN Configurator, click the Design tab.

b) Click Add Page and rename the page to “presentation”.

c) Customize the interface and add control buttons using the Properties 

settings in the right-hand column. For details, see Configuring the Control 

Interface (Viewer), page 119.

2. Define the action of each button. For example, for the PowerPoint button to 

open and start a slide show when pressed, do the following:

a) In the preview pane, click the PowerPoint button.

b) Select ControlAssist (LAN).

c) Double-click [PowerPoint] Open file and then [PowerPoint] Start 

presentation.

d) Configure the commands and arrange them in the order of execution.

Tip: The asterisk (*) at the end of a Function indicates that it requires 

configuration in the Commands column.

2b

2a

2c 2d
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For details on supported control actions, see Supported PC Control Actions, 

page 278.

3. From the Upload tab, deploy and back up the project to the controller. For 

details, see The Upload Tab, page 237.
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Supported PC Control Actions

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 

the Commands column in the Configurator.

[Media Control] 

Note: The commands in this group apply to Windows Media Player only.

Close Closes the player.

Next Plays next in the playlist.

Open file* Opens and plays the specified file in Windows Media 

Player.

Open playlist* Opens and plays the specified playlist in Windows Media 

Player.

Pause Pauses the playback.

Play Plays the opened file in Windows Media Player.

Previous Plays previous in the playlist.

Set volume to* Sets the player to a specified volume.

Stop Stops the playback.

Switch to full screen mode* Enables or disables the player to full-screen display.

Switch to mute mode* Enables or disables mute mode.

Switch to repeat mode* Enables or disables repeated play.

Volume* Adjusts the player’s volume up or down.

[PowerPoint Control]

Open file* Opens the specified PowerPoint file.

Start presentation Starts the slide show of the specified PowerPoint file.

End presentation Ends the slide show of the specified PowerPoint file.

Close Closes the opened PowerPoint file.

Go to next slide* Goes to the next slide.

Go to previous slide Goes to the previous slide.

Go to slide Goes to a specified slide number.

[System Control]

Open file* Opens a specified file saved in the target computer.

Open URL* Opens a specified URL.

Run program* Runs an application.

Shut down PC Shuts down the computer.
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Note: Adhere to the following guidelines when specifying file paths:

 Include the file name and file extension of the target file.

 Use double backward slashes between folder levels.

 If the file path contains space, put the file path in double quotations. 

 The following are examples of valid file paths:

“C:\\ControlAssist\\Presentation.pptx”

“C:\\ControlAssist\\Presentation Demo.pptx”

Set volume* Adjusts the computer’s volume.

Execute Command 

Prompt*

Executes the specified command via Command Prompt.

Bring application to top* Keeps the window of the specified program on top of 

other windows that are open on the desktop.

[Hotkey Control]

Create action Executes the associated hotkey(s) on the program that 

opens topmost on the computer desktop. 

For example, if you have “Ctrl + f” defined as the hotkey for 

extending a program to full screen in the program itself, to 

remotely simulate this action, you should have one Create 

action command associated with two Select key 

commands, one defined as “Ctrl”, and the other as “f”:

Select key* Use this command to specify the hotkey as defined in the 

target program. If the hotkey involves pressing two or 

more keys at the same time, you will have two or more 

Select key commands associated to one Create action 

command. See the example in the Create action 

command above.

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 

the Commands column in the Configurator.
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Chapter 7

ATEN Control System App

Overview

The ATEN Control System App is a platform that allows you to operate your 

control system using pre-made Viewers on mobile devices with an iOS, 

Android, or Windows platform. 

Requirements

Make sure your mobile device uses a supported version of the mobile operating 

system listed below before installing the app.

Installing the App

To install the ATEN Control System App on a mobile device, do the following:

1. From the mobile device, tap the App Store  or Google Play  

icon.

2. In the search box, type “aten control”.

3. Tap ATEN Control System, and then download and install the app. 

4. The ATEN Control System icon appears on the mobile device.Tap 

the icon to open the app. 

Note: The button sound is enabled by default. To mute button sound, go to 

Settings of the mobile device, find ATEN Control app and disable 

the button sound setting.

Mobile Operating System Supported Version

iOS 10.0 or later

Android 8.0 or later

Windows 7 or later
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Demo/Start Screen

When you open the ATEN Control System app for the first time, the demo/start 

screen appears:

Tap Demo to try the ATEN Control System app. Tap Start to find a controller 

and download Viewers (see Overview, page 287). 

Note: The default demo/start screen appears until a Viewer is downloaded to 

the Control System app. After a Viewer is downloaded, the default demo/start 

screen will reappear only if the app is reinstalled, which will also delete all 

Viewers.
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The Demo page provides two sample Viewers. Tap either one to view the 

controls of different hardware devices. 

To return to the demo/start page, tap Quit Demo at the top right corner.

Select a Viewer or press any of the buttons on the Welcome page to demo the 

app. The first Viewer’s name will depend on the OS of the device. 
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WinViewer1 / iPad / Android1
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This demo shows a Conference call interface with controls for a Projector, 

Screen and Lighting. Tap any of the device icons to open each of the 

following control pages:

. 
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Demo

This demo shows different buttons that can be pressed to control the Projector, 

Lights, Video Wall and Camera. Tap the icons to view control pages for each 

device. Tap the Quit Demo icon to return to the previous page, or press on the 

background until the logout dialog appears.

Control Pages

The images above show control pages for the Projector, Lights, Video Wall 

and Camera in Demo. Tap the Home icon in the lower left corner to return to 

the previous page, or press on the background until the logout dialog appears. 

To return to the demo/start page, tap Quit Demo at the top right corner.
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Overview

Welcome (List of Viewers) Page

The Welcome screen is the home screen of the ATEN Control System app. It 

lists downloaded Viewers and provides administrative options. Tap a Viewer 

to open the controls for a room (see Configuring the Control Interface 

(Viewer), page 119), or use the administrative options listed below.

Control Description

Manage Viewer – Use this page to add, update, and remove 

downloaded Viewers. See page 288 for details.

Manage LAN Device – Use this page to access controller’s web 

console or configure the network settings for controllers and the 

devices that they manage. See page 289 for details.

Log Report – Use this page to lookup logs to troubleshoot 

connectivity issues. See page 294 for details.

Preferences – Use this page to set a password for accessing the 

app or configure the app’s usage settings. See page 295 for details.

Settings – Use this page to access the system settings page of 

ATEN Touch Panel. This tab is only accessible when the Control 

System app is used on an ATEN Touch Panel.

Information – This page provides information about the ATEN 

Control System’s software version. See page 302 for details.
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Manage Viewer

The Manage Viewer page allows you to add, update, and remove 

downloaded Viewers. To download Viewers, tap Add Viewer. 

Control Description

Tap Add Viewer to download Viewers. See page 303 for details.

Tap the Information icon to view the MAC Address, IP Address and 

Controller ID of the controller associated with the Viewer.

Update Tap Update to connect to the controller and download an updated 

version of the Viewer. After the update, the “Downloaded Successfully” 

prompt will appear

Remove Tap Remove to delete the Viewer. A dialog box will appear to confirm 

deletion of the Viewer. 

Tap Delete to remove the Viewer, or Cancel to cancel the deletion.

Note: Viewers are only deleted on the mobile device, and will still be 

available on the controller. 

Done Tap Done to return to the Welcome page. 



Chapter 7. ATEN Control System App

289

Manage LAN Device

The Manage LAN Device page allows you to edit network settings for 

the controllers and LAN devices added in the Configurator software 

(see Device Library, page 118). 

Control Description

Tap to expand controllers to view connected LAN devices.

Tap to open the web GUI (Chapter 3, Web-Based 

Configuration and Control).
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Depending on the LAN device you select, different options are available.Tap 

on a device to open the settings page. Use Edit to change settings, Apply to 

save or OK to exit.

Controller

PJLink Projector 

Telnet 
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ONVIF 

TCP 

UDP
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Simulating Viewer Controls with Demo Mode

You can preview Viewers and simulate control actions without connecting to 

a controller using the demo mode. 

1. To simulate controls of a target Viewer, download the Viewer file.

For details, see Download Viewer, page 303.

Note: If you wish to use built-in Viewers, skip this step.

2. Tap the ATEN Control app icon from your mobile device. This screen 

appears.

Note: If you have not downloaded any Viewers to the app, a Demo/Start 

page appears. Tap Demo to use built-in Viewers for the simulation.

3. Tap Settings . The Preferences page appears.

4. Tap Enable demo mode to select the setting and tap Set. Demo mode is 

immediately applied.

5. Tap  to return to the Welcome page.

6. Tap a Viewer to view and try out its control interface.
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 To close the Viewer, long tap any space on the mobile device and click 

OK in a pop-up dialog box.

 To disable demo mode, close the Viewer and then go to Settings  

to disable the demo mode setting.
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Log Report

The Log Report page lists information and errors which can be used 

to troubleshoot issues. Tap and drag the list to scroll through the 

logs.  Tap Back to exit.

Control Description

Tap Save to save the log file.

Tap Report History to view saved logs (see page 301).

Tap Delete to delete the log information.

Tap Back to exit.
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Preferences

The Preferences page provides settings for operation preferences of 

the Control System app, access to Room Booking System, and 

AppSwitcher. 

General

 Seconds to press before the exit dialog appears: This sets the duration of 

idle time. When the app idles for the specified duration, an Exit dialog 

appears to check if the user wants to close the app.

 Screen Mode

Note: This setting only takes effect on Viewer control pages.

 Screen saver: Select this option to start a screen saver when the 

mobile device has idled for the specified duration.

 Screen lock: Select this option for the mobile device to lock the screen 

based on its related setting on the mobile device.

 Always on: Select this option to have the screen on all the time.

 Enable password protection: To restrict access to app settings and 

prevent unwanted configuration, enable password authentication for 

leaving the control pages. 
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 Allow keyboard usage when this app is in full screen: Enable this 

option to allow keyboard operation when the app is in full screen.

 Notify me when this app disconnects from the Internet: Select this 

option to notify the user when the app disconnects from the Internet.

 Connect to ATEN Control System devices based on the Manage 

Device IP list: Select this option for the app to identify and connect to 

controllers by IP address instead of the controller ID. This is useful when 

you create projects by duplication, in which case you do not need to re-

configure the controller ID in each project.

 Show alert messages for Ethernet devices managed by the controller 

(only applicable to the iOS version of the app): Enable this setting to 

receive status notifications for the managed Ethernet devices.

 Always open viewers in full screen (only applicable to the Windows 

version of the app): Enable this setting to open Viewers (i.e. control pages, 

for examples see page 284) in full screen.

 Show minimize, maximize, and close buttons (only applicable to the 

Windows version of the app): Enable this setting to show the minimize, 

maximize, and close buttons at the top-right corner of a Viewer (i.e. 

control page, for examples see page 284).

 Enable demo mode: Select this setting to allow viewing of the control 

pages within the Viewer (with no actual effects) when no controller is 

connected.

 Enable physical buttons on Viewer device (only applicable to VK330): 

To prevent access to physical buttons on the touch panel, disable this 

setting.
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Receiving Room Usage Notifications from ATEN Room Booking 

System

You can receive notifications of room usage including check-in, check-out, 

and reservation extension on ATEN Touch Panel / Android mobile device as 

soon as the action is made.

This feature also requires management and configuration of ATEN Unizon. 

For more information, see ATEN Unizon User Manual. The Access to RBS 

control setting merely allows the device to be able to receive notifications from 

ATEN Unizon.

Allowing Room Usage Notifications

1. Go to Preferences  > Advanced page, enable Access to RBS control 

to allow ATEN Unizon to send notifications to the mobile device.

2. (Optional) Enable/disable notification sound.

3. Tap Set to save the settings. The RBS control icon  appears.

Remote RBS Control

You can check in, check out, or extend meeting reservation using ATEN Touch 

Panel / Android mobile device. 

To allow these remote actions: 

1. Go to Preferences > Advanced.

2. Enable the Access to RBS Control setting and tap Set.

The RBS control icon appears.
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AppSwitcher

You can maximize the usage of an ATEN Touch Panel (VK330) using 

AppSwitcher which allows you to install multiple apps (ATEN or third-party 

apps) on the Touch Panel and to switch apps should your need changes.

Adding Apps to ATEN Touch Panel And AppSwitcher

Follow the procedure below to install apps to an ATEN Touch Panel and to add 

them to AppSwitcher to make them available for switching.

1. Go to Preferences  > Advanced, enable the Access to app switch 

setting.

2. Tap Add App to install an app to the mobile device.

3. Tap  to refresh the list. The installed apps appear on the list.

4. To make an app available for switching, tap the app to add it to 

AppSwitcher. Apps added to AppSwitcher are marked with black  

icon. Tap again to unselect. You can add multiple apps to AppSwitcher.

5. Tap Set. The AppSwitcher control icon  appears.

6. To uninstall an app, tap Remove App.
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Using AppSwitcher

You can switch among the installed and added apps using AppSwitcher. 

1. On your Viewer, find the AppSwitcher control . 

If you can not find the control, go to Preferences  > Advanced page, 

enable the Access to app switch setting, and tap Set. The AppSwitcher 

control should appear.

2. Tap . A list of available apps appear. 

3. Tap from the list to switch the control to the selected app. 

For example:
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Note: If the app you wish to use is not in the list, tap Go to Preferences, 

and then make sure the app is installed and added to AppSwitcher. 

For detailed instructions, see Adding Apps to the Device and 

AppSwitcher, page 298.

4. To return to the previous control page, tap Back to main control.
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Report History

When you tap Report History, you can view and export logs. Saved 

log files are listed by date in the left column. Tap a log file to view it 

in the window to the right. Tap and drag the list to scroll through the 

logs. Tap Back to exit.

 Tap Export to send the log as an e-mail attachment.
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Information

The Information page displays the ATEN Control System’s version.
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Download Viewer

The Download Viewer page allows you to search for controllers and 

download Viewers. This page is accessed from Welcome → Manage 

Viewer → Add Viewer.

Control Description

Search by IP 
Address

Tap to enter a controller’s IP address, then tap the Search icon to 
find it. When controllers are found on the network, they are listed in 
the Add Viewer box.

A Search History drop-down menu will appear for previously 
searched IP addresses. 

Auto Search Auto Search allows you to search for controllers without specifying 
an IP address. The controller must be powered on and connected 
to the same local network. 

Add Viewer This panel lists the controllers that have been found on the 
network. Each controller lists Viewers that can be downloaded to 
the mobile device. To upload Viewers to a controller, see The 
Upload Tab, page 237.

Back Icon Back returns you to the Welcome page.

Download After you select the Viewers you want to download, click 
Download to start the process.
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Downloading Viewers

When controllers are found, they appear in the Add Viewer 

panel. Check the boxes of the Viewers you would like to 

download, then tap Download. 

Control Description

Add Viewer The main window lists the controllers that have been found on the 
network. Under each controller is a list of Viewers with a check box. 

Use the check boxes to select the Viewers you want to download, 
then click Download. If the Lock icon appears, you will be prompted 
to enter the access key. 

After Viewers download, the “Downloaded Successfully” prompt 
appears. Tap Done to return to the Welcome page where the 
Viewers will be listed. 

Note: After you download a Viewers to the mobile device, the default 
Welcome screen no longer appears. 

Access Key When the a Viewers requires an access key a window appears 
prompting you to enter the key. Enter the correct access key and 
then click OK to download the Viewers from the controller. To set the 
access key, see The Upload Tab, page 237. 

Tap the Information icon to view the IP Address, MAC Address and 
License information of the controller. The license information 
provides the total number of licenses available and the number in 
use. 
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Chapter 8

SSH Commands

Overview

ATEN expansion boxes support SSH and can be configured via an SSH client 

such as PuTTY.

Establishing an SSH Session with Expansion Box

1. On a computer installed under the same network with the target ATEN 

Expansion Box, install an SSH client, e.g. PuTTY.

2. Run the SSH client.

3. Establish an SSH session with the target Expansion Box using the 

following settings:

 Port: 22

 IP address of the Expansion Box

 Access key of the Expansion Box

Note: If the session can not be established, log in the Expansion Box’s web 

console to check if the access key needs to be changed.

4. Execute commands to configure and/or control the expansion box. For 

more information on commands, see:

 Command Syntax, page 306

 Command List, page 307
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Command Syntax

 The general form of a command is:

command parameter<argument> {one|two|three}

 If you have two or more parameters, the order of these parameters among 

themselves does not affect the result of the operation. For example, both of 

the following commands execute the same task: 

command name + parameter 1 + parameter 2

command name + parameter 2 + parameter 1

Notation Description

command The name of the command is shown in bold.

parameter Indicates the name of the parameter.

<argument> Indicates the name of the value or the information that the user 

must provide. Only type the information in the angle brackets, not 

the brackets themselves.

[ ] Indicates optional items. Only type the information in the brackets, 

not the brackets themselves.

{ } Indicates a set of choices from which the user must choose one. 

Only type one of the choices in the brackets, not the brackets 

themselves.

| Indicates two or more mutually exclusive choices in a command 

line. Only type one of the choices in the command line, not the 

symbol.
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Command List

Configuring Serial Settings

 Function

Configure or display ATEN Expansion Boxes’ serial settings. 

 Syntax

serial [p<port number>] [type <serial interface>] [baud 

<buadrate>] [dbit <databit>] [parity <sparity>] [sbit 

<stopbit>] [fctrl <flowctrl>] [dtype <datatype>] 

[endchar <chars>] [acktimeout <duration>] [control 

<data>]

 Command & Parameters

Function Command/Parameter Input (argument)

To display current 

settings for all serial 

ports when the 

command is used on its 

own.

serial N/A

To specify the serial 

port(s) for the command 

action.

p<port number> p01: port 1

p01,02: port 1 and 2

p*: all ports

p: all ports

To specify the type of 

serial interface.

type <serial 

interface>

232, 422, 485

To set the baud rate. baud <buad rate> 300, 600, 1200, 

2400, 4800, 9600, 

19200, 38400, 

57600, 115200

To set the databit. dbit <databit> 7, 8

To set the serial parity. parity <parity> none, even, odd

To set the stop bit. sbit <stopbit> 1, 2

To set the flow control. fctrl <flow ctrl> none, hw

To specify the data type 

(ASCII or HEX).

dtype <datatype> ascii, hex

Note: If this parameter is 

not specified, the default 

setting is ascii.
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 Examples

serial: display the current settings for all serial ports

serial p01 type 232 baud 115200 dbit 8 parity none sbit 

1 fctrl none: set port 1 to the specified settings.

serial p01,04,07 baud 9600: set the baud rate of port 1, 4, and 7 to 

9600.

serial p02 dtype hex read: display the log for port 2 in hex format

To set the timeout 

duration.

acktimeout <duration> Specify the timeout 

duration in milliseconds.

To specify the end-of-

text character.

endchar <chars> Specify the end-of-text 

character for the 

connected device.

To display the log of the 

target port in the 

specified data format.

read N/A

To send data from the 

specified port.

write<data> e.g. “abc123”

To send data from the 

specified port and 

request feedback.

sendack<data> N/A

Function Command/Parameter Input (argument)
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Configuring Relay Settings

 Function

Configure or display ATEN Expansion Boxes’ relay settings.

 Syntax

relay [r<port number>] [tpulse <duration>] 

[on|off|pulse|toggle|read]

 Command & Parameters

 Examples (full commands)

relay: display the current settings for all relay ports.

relay r****: display current settings for all relay ports.

relay r01 open: Turn relay port 1 on.

Function Command/Parameter Input (argument)

To display current settings for 

all relay ports when the 

command is used on its own.

relay N/A

To specify the relay port(s) for 

the command action.

r<port number> r01: port 1

r01,02: port 1 and 2

r*: all ports

r: all ports

To turn the specified relay 

port(s) on.

open N/A

To turn the specified relay 

port(s) off.

close N/A

To turn off one or more relay 

port(s) for the specified 

duration.

tpulse <duration> tpulse 500: turn the 

relay off for 500 ms 

and then turn it back 

on.

To turn the relay port off and 

then back on.

pulse N/A

To change the status of the 

specified relay port(s), for 

example, from on to off, or 

vice versa.

toggle N/A

To display settings for the 

specified relay port(s)

read N/A
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relay r01, 04, 07, 12 close: turn port 1, 4, 7 and 12 off.

relay r02 tpulse 500 pulse: turn off port 2 for 500 milliseconds and 

then turn it back on.

relay r02 read: display the current settings for port 2.

Configuring I/O Settings

 Function

Configure or display ATEN Expansion Boxes’ digital input/output settings.

 Syntax

io [p<port number>] [type <io type>] [lthresh 

<threshold>] [hthresh <threshold>] [tpulse <duration>] 

[high|low|pulse|toggle|read]

 Command & Parameters

Function Command/Parameter Input (argument)

To display current settings 

for all digital I/O ports when 

the command is used on its 

own.

io N/A

To specify the I/O port(s) for 

the command action.

p<port number> p01: port 1p01,02: port 1 and 2p*: all portsp: all ports

To specify the I/O type. type <io type> vdc: VDC input

dout: digital output

dry: dry contact

To specify the low-bound 

voltage threshold.

lthresh <threshold> N/A

To specify the high-bound 

voltage threshold.

hthresh <threshold> N/A

To specify the duration that 

the specified port(s) remain 

disabled.

tpulse <duration> N/A
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 Examples (full commands)

io: display the current settings for all digital I/O ports.

io p****: display current settings for all digital I/O ports.

io p01 type din lthresh 1 hthresh 3: Set the low voltage to 1 

and high voltage to 3 for port 1.

io r01, 04, 07, 12 close: Enable port 1, 4, 7, and 12 by closing the 

circuits of these ports.

io r02 tpulse 500 pulse: turn off port 2 for 500 milliseconds and then 

turn it back on.

io r02 read: display the current settings of port 2.

To disable the specified 

port(s) by opening the circuit 

with a high voltage.

open N/A

To enable the specified 

port(s) by closing the circuit 

with a low voltage.

close N/A

To turn the I/O port(s) off and 

then back on.

pulse N/A

To change the status of the 

specified digital I/O port(s), 

for example, from on to off, 

or vice versa.

toggle N/A

To display settings for the 

specified relay port(s).

read N/A

Function Command/Parameter Input (argument)
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Appendix

Safety Instructions

General

 Read all of these instructions. Save them for future reference.

 Follow all warnings and instructions marked on the device.

 This product is for indoor use only.

 Do not place the device on any unstable surface (cart, stand, table, etc.). If 

the device falls, serious damage will result.

 Caution: Risk of explosion if the battery is replaced by an incorrect type. 

Always dispose of used batteries according to the proper instructions.

 Do not use the device near water.

 Do not place the device near, or over, radiators or heat registers.

 The device cabinet is provided with slots and openings to allow for 

adequate ventilation. To ensure reliable operation, and to protect against 

overheating, these openings must never be blocked or covered.

 The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 

this will block its ventilation openings. Likewise, the device should not be 

placed in a built in enclosure unless adequate ventilation has been provided.

 Never spill liquid of any kind on the device.

 Unplug the device from the wall outlet before cleaning. Do not use liquid 

or aerosol cleaners. Use a damp cloth for cleaning.

 The device should be operated from the type of power source indicated on 

the marking label. If you are not sure of the type of power available, 

consult your dealer or local power company.

 To prevent damage to your installation it is important that all devices are 

properly grounded.

 Do not allow anything to rest on the power cord or cables. Route the 

power cord and cables so that they cannot be stepped on or tripped over.

 Position system cables and power cables carefully; Be sure that nothing 

rests on any cables.

 Never push objects of any kind into or through cabinet slots. They may 

touch dangerous voltage points or short out parts resulting in a risk of fire 

or electrical shock.
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 Do not attempt to service the device yourself. Refer all servicing to 

qualified service personnel.

 If the following conditions occur, unplug the device from the wall outlet 

and bring it to qualified service personnel for repair.

 The power cord or plug has become damaged or frayed.

 Liquid has been spilled into the device.

 The device has been exposed to rain or water.

 The device has been dropped, or the cabinet has been damaged.

 The device exhibits a distinct change in performance, indicating a need 

for service.

 The device does not operate normally when the operating instructions 

are followed.

 Only adjust those controls that are covered in the operating instructions. 

Improper adjustment of other controls may result in damage that will 

require extensive work by a qualified technician to repair.

 Avoid circuit overloads. Before connecting equipment to a circuit, know 

the power supply’s limit and never exceed it. Always review the electrical 

specifications of a circuit to ensure that you are not creating a dangerous 

condition or that one doesn’t already exist. Circuit overloads can cause a 

fire and destroy equipment.
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Rack Mount

 Before working on the rack, make sure that the stabilizers are secured to 

the rack, extended to the floor, and that the full weight of the rack rests on 

the floor. Install front and side stabilizers on a single rack or front 

stabilizers for joined multiple racks before working on the rack.

 Always load the rack from the bottom up, and load the heaviest item in the 

rack first.

 Make sure that the rack is level and stable before extending a device from 

the rack.

 Use caution when pressing the device rail release latches and sliding a 

device into or out of a rack; the slide rails can pinch your fingers.

 After a device is inserted into the rack, carefully extend the rail into a 

locking position, and then slide the device into the rack.

 Do not overload the AC supply branch circuit that provides power to the 

rack. The total rack load should not exceed 80 percent of the branch circuit 

rating.

 Make sure that all equipment used on the rack – including power strips and 

other electrical connectors – is properly grounded.

 Ensure that proper airflow is provided to devices in the rack.

 Ensure that the operating ambient temperature of the rack environment 

does not exceed the maximum ambient temperature specified for the 

equipment by the manufacturer.

 Do not step on or stand on any device when servicing other devices in a 

rack.
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Technical Support

International

 For online technical support – including troubleshooting, documentation, 

and software updates: http://eservice.aten.com

 For telephone support, see Telephone Support, page iv:

North America

When you contact us, please have the following information ready beforehand:

 Product model number, serial number, and date of purchase.

 Your computer configuration, including operating system, revision level, 

expansion cards, and software.

 Any error messages displayed at the time the error occurred.

 The sequence of operations that led up to the error.

 Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

https://eservice.aten.com

Telephone Support 1-888-999-ATEN ext 4988
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Specifications

VK0100 VK0200

Interface

Keypad Layout Up to 14 layout variations 

using 4 ~ 8 buttons 

Up to 125 layout 

variations using 6 ~ 12 

buttons

Serial • 2 x Bidirectional RS-232 Port (2 x 3-Pole Terminal 

Block Connector)

• Baud Rate: 300 to 115200 (default: 9600)

• Data Bit: 8 (default) or 7

• Stop Bit: 1 (default) or 2

• Parity: None (default), even or odd

Relay • 2 x Relay Channel (2 x 2-Pole Terminal Block 

Connector)

• Normally open, isolated Relays

• Contact Rating: Max 24 VDC, 1A

Digital Input • 1 x Digital Input Channel (1 x 2-Pole Terminal 

Block Connector); 

• VDC Mode 

 - Input Voltage Range: 0 to 5 V DC

 - Programmable Range: 1 to 5 V DC

• Dry Contact Mode 

 - Pull-up 2k ohms to + 5 V DC

Ethernet • 1 x RJ-45 Female, 10/100Base-T 

• Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH 

• DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is assigned 

within 30 seconds of connecting to the network.

Switches & Buttons

Controller ID Switch 1 x 16-segment Switch

Reset Button 1 x Semi-recessed Pushbutton

Power

Power Consumption DC 5 V : 1.1 W : 5 BTU

DC 48 V : 1.375 W : 6 

BTU

DC 5 V : 1.15 W : 5 BTU

DC 48 V : 1.44 W : 7 

BTU

Environmental
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Operating Temperature 0 – 50 °C

Storage Temperature –20 – 60 °C

Humidity 0 - 80% RH, Non-Condensing

Physical Properties

Housing Plastic

Weight 0.35 kg (0.77 lb) 0.38 kg (0.84 lb)

Dimensions 11.63 x 7.06 x 4.84 cm

(4.58 x 2.78 x 1.91 in)

8.32 x 14.76 x 4.84 cm

(3.28 x 5.81 x 1.91 in)

Mobile Control License

No. of free licenses 0

Max. no. of paid 

licenses

10

Note: Each time a mobile device connects to an ATEN Control Pad for 

remote control, one license on the Control Pad will be occupied. To purchase 

and add additional licenses to your Control Pad, contact your local sales 

representative for more information.

VK0100 VK0200
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VK108US VK112EU

Interface

Keypad Layout 4 ~ 8 buttons 

customizable to 14 

layouts

6 ~ 12 buttons 

customizable to 125 

layouts

Ethernet • 1 x RJ-45 Female, 10/100Base-T 

• Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS

• DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is assigned 

within 30 seconds of connecting to the network.

Switches & Buttons

Controller ID Switch 1 x 16-segment switch

Keypad ID Switch 1 x 8-segment switch

Reset Button

1 x semi-recessed pushbutton

Power

Power Consumption DC 5 V : 1.25 W : 6 BTU

DC 48 V : 1.58 W : 7 

BTU

DC 5 V : 1.25 W : 6 BTU

PoE: 1.56 W : 7 BTU

Environmental

Operating Temperature 0 – 50 °C

Storage Temperature –20 – 60 °C

Humidity 0 - 80% RH, Non-Condensing

Physical Properties

Housing Plastic

Weight 0.13 kg (0.29 lb) 0.17 kg (0.37 lb)

Device Dimensions 11.63 x 7.06 x 4.84 cm

(4.58 x 2.78 x 1.91 in)

8.32 x 14.76 x 4.80 cm

(3.28 x 5.81 x 1.89 in)

Faceplate Dimensions 11.92 x 7.42 x 0.92 cm

(4.69 x 2.92 x 0.36 in)

8.62 x 15.12 x 0.92 cm

(3.39 x 5.95 x 0.36 in)
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VK1100A

Memory

SDRAM 512 MB

Flash 8 GB

Interfaces

Serial 1 x Programmable bidirectional 

RS-232/422/485 port (1 x 5-pole terminal block 

connector, configurable via pin assignments)

 Baud Rate: 300 to 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Flow Control: None (default) or RTS/CTS

1 x bidirectional RS-232 port

(1 x 3-pole terminal block connector)

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

IR/Serial 2 x Programmable IR / Unidirectional 

RS-232 Ports (2 x 2-Pole Terminal Block 

Connectors)

IR: 

 Carrier Frequency: 10 ~ 455 kHz

 Signal Level: TTL (0 ~ 5 V DC)

Serial: 

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Signal Level: TTL (0 ~ 5 V DC)
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I/O 2 x Programmable Digital Input / Output Channels 

(1 x 3-Pole Terminal Block Connector)

Digital Output: 

300 mA sink from 24 V DC

Digital Input:

VDC Mode 

 Input Voltage Range: 0 ~ 24 V DC

 Programmable Range: 1 ~ 24 V DC

Dry Contact Mode

 Pull-up 2 kΩ to +12 V DC

Relay  4 x Relay Channels (2 x 4-Pole Terminal Block 

Connector)

 Normally Open, Isolated Relays

 Contact Rating: Max 24 V DC, 2 A

V DC  1 x 12 V DC Output Port (1 x 2-Pole Terminal 

Block Connector)

 Power Supply: 12 V DC, 1 A Max

Ethernet  2 x RJ-45 Female, 10/100/1000 Base-T

 Supported protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60 / 192.168.1.60 for Control LAN / 

LAN, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is 

assigned within 30 seconds of connecting to the 

network.

USB 1 x USB Type-A

Switches

Power 1 x on/off Switch

IR Learning

1 x IR Receiver LED

Reset Button

1 x Semi-recessed pushbutton

VK1100A
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Power

Power Consumption AC 110 V : 4.3 W

AC 220 V : 4.5 W

Maximum Input Power 

Rating

internal power: 100 - 240 V AC, 50 - 60 Hz

Environmental

Operating Temperature 0 – 50 ºC

Storage Temperature -20 – 60 ºC

Humidity 0 – 80% RH, Non-condensing

Physical Properties

Housing Metal

Weight 1.19 kg

Dimensions (L x W x H) 21.50 x 16.23 x 4.18 cm

Mobile Control License

No. of free licenses 2

Max. no. of licenses 16

Note: The ATEN Control Box Gen. 2 comes with two free licenses which are 

stored in the device itself. Each time a mobile device connects to an ATEN

Control Box Gen. 2 for remote control, one license on the Control Box Gen. 2 

will be occupied. To purchase and add additional licenses to your Control 

Box, contact your local sales representative for more information.

VK1100A
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VK1200

System

CPU Quad-core Processor

SD RAM 1 GB

Flash Memory 8 GB

Interface

Serial 1 x Programmable bidirectional 

RS-232/422/485 port (1 x 5-pole terminal 

block connector)

1 x Programmable bidirectional RS-232 port

(1 x 3-pole terminal block connector)

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Flow Control: None (default) RTS/CTS 

(for 5-pole terminal block)

IR/Serial 2 x Programmable IR / Unidirectional 

RS-232 Ports (2 x 2-Pole Terminal Block 

Connectors)

IR: 

 Carrier Frequency: 10 ~ 455 kHz

 Signal Level: TTL (0 ~ 5 V DC)

Serial: 

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Signal Level: TTL (0 ~ 5 V DC)
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I/O 2 x Programmable Digital Input / Output 

Channels (1 x 3-Pole Terminal Block 

Connector)

Digital Output: 300 mA sink from 24 V DC

Digital Input:

VDC Mode 

 Input Voltage Range: 0 ~ 24 V DC

 Programmable Range: 1 ~ 24 V DC

Dry Contact Mode

 Pull-up 2 kΩ to +12 V DC

Relay  4 x Relay Channels (2 x 4-Pole Terminal 

Block Connector)

 Normally Open, Isolated Relays

 Contact Rating: Max 24 V DC, 2 A

V DC  1 x 12 V DC Output Port (1 x 2-Pole 

Terminal Block Connectors)

 Power Supply: 12 V DC, 1 A Max

Ethernet  2 x RJ-45 Female, 10/100/1000 Base-T

 Supported protocol: ARP, ICMP, TCP/IP, 

DHCP, HTTPS, SSH

 DHCP-enabled. Default IP settings (IP 

address 192.168.0.60 / 192.168.1.60 for 

Control LAN / LAN, subnet mask 

255.255.255.0) will be automatically 

applied if no IP address is assigned within 

30 seconds of connecting to the network.

USB 1 x USB Type-A

LCD Panel

Size 1.6”

LCM Display 64 x 128 resolution

LCM Setting 3 x Pushbuttons (Up, Down, Enter)

Switches

Power 1 x on/off Switch

VK1200
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IR Learning

1 x IR Receiver LED

Reset Button

1 x Semi-recessed pushbutton

Power

Power Consumption AC 110 V : 4.7 W : 81 BTU

AC 220 V : 4.5 W : 81 BTU

Maximum Input Power Rating internal power: 100 - 240 V AC, 50 - 60 Hz

Environmental

Operating Temperature 0 – 50 ºC

Storage Temperature -20 – 60 ºC

Humidity 0 – 80% RH, Non-condensing

Physical Properties

Housing Metal

Weight 1.23 kg

Dimensions (L x W x H) 20.00 x 16.41 x 4.40 cm

Mobile Control License

No, of free licenses 2

Max. no. of licenses 32

Note: The ATEN Control Box comes with two free licenses which are stored 

in the device itself. Each time a mobile device connects to an ATEN

Control Box for remote control, one license on the Control Box will be 

occupied. To purchase and add additional licenses to your Control Box, 

contact your local sales representative for more information.

VK1200
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VK2100A

Memory

SDRAM 1 GB

Flash 8 GB

Interfaces

Serial 2 x Programmable bidirectional 

RS-232/422/485 ports (2 x 5-pole terminal block 

connector, configurable via pin assignments)

 Baud Rate: 300 to 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Flow Control: None (default) or RTS/CTS

4 x bidirectional RS-232 ports

(4 x 3-pole terminal block connectors)

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

IR/Serial 4 x Programmable IR / Unidirectional 

RS-232 Ports (2 x 2-Pole Terminal Block 

Connectors)

IR:

 Carrier Frequency: 10 ~ 455 kHz

 Signal Level: TTL (0 ~ 5 V DC)

Serial (Unidirectional RS-232):

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Signal Level: 0 to 5V DC
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I/O 4 x Programmable Digital Input / Output Channels 

(1 x 5-Pole Terminal Block Connector)

Digital Output: 

300 mA sink from 24 V DC

Digital Input:

 VDC Mode 

 Input Voltage Range: 0 ~ 24 V DC

 Programmable Range: 1 ~ 24 V DC

 Dry Contact Mode

 Pull-up 2 kΩ to +12 V DC

Relay  4 x Relay Channels (2 x 4-Pole Terminal Block 

Connector)

 Normally Open, Isolated Relays

 Contact Rating: Max 24 V DC, 2 A

V DC  4 x 12 V DC Output Port (2 x 4-Pole Terminal 

Block Connectors)

 Power Supply: 12 V DC, 2 A Max (shared by 4 

ports)

Ethernet  2 x RJ-45 Female, 10/100/1000 Base-T

 Supported protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60 / 192.168.1.60 for Control LAN / 

LAN, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is 

assigned within 30 seconds of connecting to the 

network.

USB 1 x USB Type-A

Switches

Power 1 x on/off Switch

IR Learning

1 x IR Receiver LED

Reset Button

1 x Semi-recessed pushbutton

VK2100A



ATEN Control System User Manual

328

Power

Power Consumption AC 110 V : 5.2 W

AC 220 V : 6.5 W

Maximum Input Power 

Rating

internal power: 100 - 240 V AC, 50 - 60 Hz

Environmental

Operating Temperature 0 – 50 ºC

Storage Temperature -20 – 60 ºC

Humidity 0 – 80% RH, Non-condensing

Physical Properties

Housing Metal

Weight 2.64 kg

Dimensions (L x W x H) 43.72 x 16.32 x 4.40 cm

Mobile Control License

No. of free licenses 2

Max. no. of licenses 16

Note: The ATEN Control Box Gen. 2 comes with two free licenses which are 

stored in the device itself. Each time a mobile device connects to an ATEN

Control Box Gen. 2 for remote control, one license on the Control Box Gen. 2 

will be occupied. To purchase and add additional licenses to your Control 

Box, contact your local sales representative for more information.

VK2100A
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VK2200

System

CPU Quad-core Processor

SD RAM 2 GB

Flash Memory 8 GB

Interface

Serial 2 x Bidirectional RS-232/422/485 Ports

(2 x 5-Pole Terminal Block Connectors)

6 x Programmable Bidirectional RS-232 Ports

(6 x 3-Pole Terminal Block Connector)

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even or Odd

 Flow Control: None (default) RTS/CTS

(for 5-pole terminal block)

IR/Serial 8 x Programmable IR / Unidirectional RS-232 

Ports (4 x 4-Pole Terminal Block Connectors)

IR: 

 Carrier Frequency: 10 ~ 455 kHz

 Signal Level: TTL (0 ~ 5 V DC)

Serial:

 Baud Rate: 300 ~ 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even, or Odd

 Signal Level: TTL (0 ~ 5 V DC)
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I/O 8 x Programmable Digital Input / Output 

Channels (2 x 5-Pole Terminal Block Connectors)

Digital Output: 300 mA sink from 24 V DC

Digital Input:

VDC Mode 

 Input Voltage Range: 0 ~ 24 V DC

 Programmable Range: 1 ~ 24 V DC

Dry Contact Mode

 Pull-up 2 kΩ to +12 V DC

Relay  8 x Relay Channels (4 x 4-Pole Terminal 

Block Connector)

 Normally Open, Isolated Relays

 Contact Rating: Max 24 V DC, 2 A

V DC  4 x 12 V DC Output Ports (2 x 4-Pole Terminal 

Block Connectors)

 Power Supply: 12 V DC, 2 A Max (Shared By 

4 Ports)

Ethernet  2 x RJ-45 Female, 10/100/1000 Base-T

 Supported protocol: ARP, ICMP, TCP/IP, 

DHCP, HTTPS, SSH

 DHCP-enabled. Default IP settings (IP 

address 192.168.0.60 / 192.168.1.60 for 

Control LAN / LAN, subnet mask 

255.255.255.0) will be automatically applied if 

no IP address is assigned within 30 seconds 

of connecting to the network.

USB 1 x USB Type-A

LCD Panel

Size 1.6”

LCM Display 64 x 128 resolution

LCM Setting 3 x Pushbuttons (Up, Down, Enter)

Switches

Power 1 x on/off switch

IR Learning

VK2200
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1 x IR Receiver LED

Reset Button

1 x Semi-recessed pushbutton

Power

Power Consumption AC 110 V : 5.7 W : 139 BTU
AC 220 V : 6.8 W : 144 BTU

Max. Input Power Rating Internal power: 100 - 240 V AC, 50 - 60 Hz

Environmental

Operating Temperature 0 – 50 ºC

Storage Temperature -20 – 60 ºC

Humidity 0 – 80% RH, Non-condensing

Physical Properties

Housing Metal

Weight 2.62 kg

Dimensions (L x W x H) 43.24 x 16.32 x 4.40 cm

Mobile Control License

No, of free licenses 2

Max. no. of licenses 32

Note: The ATEN Control Box comes with two free licenses which are stored 

in the device itself. Each time a mobile device connects to an ATEN

Control Box for remote control, one license on the Control Box will be 

occupied. To purchase and add additional licenses to your ATEN

Control Box, contact your local sales representative for more information.

VK2200
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VK330

Panel Specifications

Display Type TFT-LCD

Size 10.1”

Touch Screen Capacitive

Resolution 1280 x 800

Aspect Ratio 16:9

Color Depth 8 bit

Contrast Ratio 800:1

Backlight LED

Viewing Angle ±85º (H), ±85º (V)

Interfaces

Ethernet 1 x 4J-45 Female, 10/100/1000 BaseT

USB 1 x USB Type-A

Power

Power over Ethernet (PoE) 802.3 at PoE+

Power Consumption PoE:14W:47.77BTU

Environmental

Operating Temperature 0–40 ºC

Storage Temperature -10–55 ºC

Humidity 10–80% RH, Non-condensing

Physical Properties

Housing ABS + PC

Weight 0.62 kg (1.37 lb)

Dimensions (L x W x H) 25.22 x 17.78 x 2.45 cm (9.93 x 7 x 0.96 in.)
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VK224

Interfaces

Serial 4 x programmable, bi-directional RS-232/422/485 
ports (4 x DB9 Male Connector, configurable via pin 
assignments)

 Baud Rate: 300 to 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even or Odd

 Flow Control: None (default) RTS/CTS

RS-232

 Pin 2: RX

 Pin 3: TX

 Pin 5: GND

 Pin 7: RTS

 Pin 8: CTS

RS-422

 Pin 1: RX-

 Pin 2: RX+

 Pin 3: TX+

 Pin 4: TX-

 Pin 5: GND

RS-485

 Pin 3: D+

 Pin 4: D-

 Pin 5: GND* 

Note: A ground terminal connection is 

recommended but not required.

Ethernet  1 x RJ-45 Female, 10/100Base-T

 Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will 

be automatically applied if no IP address is 

assigned within 30 seconds of connecting to the 

network.
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Switches

Controller ID 1 x 16-segment Switch

Expansion Box ID 1 x 8-segment Switch

Reset Button

1 x Semi-recessed Pushbutton

USB

1 x USB Type A

Power Consumption

DC5V:3.8W:28BTU; DC48V:4.75W:33BTU

Environmental

Operating Temperature 0–50 ºC

Storage Temperature -20–60 ºC

Humidity 0–80% RH, Non-condensing

Physical Properties

Housing Metal

Metal 0.45 kg (0.99 lb)

Dimensions (L x W x 
H)

13.00 x 7.58 x 4.20 cm (5.12 x 2.98 x 1.65 in.)

VK224
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VK236

Interfaces

IR/Serial 6 x Programmable IR / Uni-directional RS-232 Port

6 x 2-Pole Terminal Block Connector

IR: TTL level (0 to 5 V)

 Carrier Frequency: 10KHz~455KHz;

 Serial: Uni-directional RS-232 (+ - 5 V)

 Baud Rate: 300 to 115200 (default: 9600)

 Data Bit: 8 (default) or 7

 Stop Bit: 1 (default) or 2

 Parity: None (default), Even or Odd

Ethernet  1 x RJ-45 Female, 10/100Base-T

 Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is assigned 

within 30 seconds of connecting to the network.

Switches

Controller ID 1 x 16-segment Switch

Expansion Box ID 1 x 8-segment Switch

Reset Button

1 x Semi-recessed Pushbutton

USB

1 x USB Type A (firmware upgrades only)

Power Consumption

DC5V:1.31W:17BTU; DC48V:1.64W:18BTU

Environmental

Operating Temperature 0–50 ºC

Storage Temperature -20–60 ºC

Humidity 0–80% RH, Non-condensing

Physical Properties

Housing Metal

Metal 0.45 kg (0.99 lb)

Dimensions (L x W x H) 13.00 x 7.58 x 4.20 cm (5.12 x 2.98 x 1.65 in.)
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VK248

Interfaces

Relay  8 normally open relays (8 x 2-pole terminal block)

 Contact Rating: Max 24 VDC, 2A

Ethernet  1 x RJ-45 Female, 10/100Base-T

 Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is assigned 

within 30 seconds of connecting to the network.

Switches

Controller ID 1 x 16-segment Switch

Expansion Box ID 1 x 8-segment Switch

Reset Button

1 x Semi-recessed Pushbutton

USB

1 x USB Type A (firmware upgrades only)

Power Consumption

DC5V:2.82W:24BTU; DC48V:3.53W:27BTU

Environmental

Operating Temperature 0–50 ºC

Storage Temperature -20–60 ºC

Humidity 0–80% RH, Non-condensing

Power Output

12 VDC, 300mA

Physical Properties

Housing Metal

Metal 0.65 kg (1.43 lb)

Dimensions (L x W x H) 20.00 x 7.58 x 4.20 cm (7.87 x 2.98 x 1.65 in.)
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VK258

Interfaces

Relay  8 x Programmable Digital Input / Output Channel

 Digital Input

 VDC Mode

Input Voltage Range: 0 to 24 VDC

Programmable Range: 1 to 24 VDC

 Dry Contact Mode

Pull-up 2k ohms to +12 VDC

 Digital Output: 300 mA sink from 24 VDC

Ethernet  1 x RJ-45 Female, 10/100Base-T

 Supported Protocol: ARP, ICMP, TCP/IP, DHCP, 

HTTPS, SSH

 DHCP-enabled. Default IP settings (IP address 

192.168.0.60, subnet mask 255.255.255.0) will be 

automatically applied if no IP address is assigned 

within 30 seconds of connecting to the network.

Switches

Controller ID 1 x 16-segment Switch

Expansion Box ID 1 x 8-segment Switch

Reset Button

1 x Semi-recessed Pushbutton

USB

1 x USB Type A (firmware upgrades only)

Power

Power Consumption DC5V:2.2W:36BTU; PoE:2.75W:39BTU

Power Output 12 VDC, 300 mA

Environmental

Operating Temperature 0–50 ºC

Storage Temperature -20–60 ºC

Humidity 0–80% RH, Non-condensing

Physical Properties

Housing Metal

Metal 0.46 kg (1.01 lb)

Dimensions (L x W x H) 13.00 x 7.58 x 4.20 cm (5.12 x 2.98 x 1.65 in.)
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Control System Project Specifications

Project Elements Maximum Number

Managed IP devices VK0100 / VK0200 8

VK1100A / VK2100A 25

VK1200 / VK2200 64

Rooms 16

Viewers 32

Macros 1024

Variables 1024

monitoring event

VK0100 / VK0200 10

VK1100A / VK2100A 20

VK1200 / VK2200 40

scheduling event VK1100A / VK2100A

60VK1200 / VK2200

Viewer pages 160 per Viewer

control objects 320 per page

commands 128 per button
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CAD Drawings
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Datapoint Types

ATEN Control System supports the following KNX Datapoint Types (DPT): 

DPT ID DPT Format DPT Name

1.001 B1 DPT_Switch

1.002 B1 DPT_Bool

1.003 B1 DPT_Enable

1.004 B1 DPT_Ramp

1.005 B1 DPT_Alarm

1.006 B1 DPT_BinaryValue

1.007 B1 DPT_Step

1.008 B1 DPT_UpDown

1.009 B1 DPT_OpenClose

1.010 B1 DPT_Start

1.011 B1 DPT_State

1.012 B1 DPT_Invert

1.013 B1 DPT_DimSendStyle

1.014 B1 DPT_InputSource

1.015 B1 DPT_Reset

1.016 B1 DPT_Ack

1.017 B1 DPT_Trigger

1.018 B1 DPT_Occupancy

1.019 B1 DPT_Window_Door

1.021 B1 DPT_LogicalFunction

1.022 B1 DPT_Scene_AB

1.023 B1 DPT_ShutterBlinds_Mode

1.100 B1 DPT_Heat/Cool

2.001 B2 DPT_Switch_Control

2.002 B2 DPT_Bool_Control

2.003 B2 DPT_Enable_Control

2.004 B2 DPT_Ramp_Control
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2.005 B2 DPT_Alarm_Control

2.006 B2 DPT_BinaryValue_Control

2.007 B2 DPT_Step_Control

2.008 B2 DPT_Direction1_Control

2.009 B2 DPT_Direction2_Control

2.010 B2 DPT_Start_Control

2.011 B2 DPT_State_Control

2.012 B2 DPT_Invert_Control

3.007 B1U3 DPT_Control_Dimming

3.008 B1U3 DPT_Control_Blinds

4.001 A8 DPT_ASCII

4.002 A8 DPT_Char_8859_1

5.001 U8 DPT_Scaling

5.003 U8 DPT_Angle

5.004 U8 DPT_Percent_U8

5.005 U8 DPT_DecimalFactor

5.006 U8 DPT_Tariff

5.010 U8 DPT_Value_1_Ucount

6.001 V8 DPT_Percent_V8

6.010 V8 DPT_Value_1_Count

6.020 B5N3 DPT_Status_Mode3

7.013 U16 DPT_Brightness

8.011 V16 DPT_Rotation_Angle

9.001 F16 DPT_Value_Temp

18.001 B1R1U6 DPT_SceneControl

20.100 N8 DPT_FuelType

20.101 N8 DPT_BurnerType

20.102 N8 DPT_HVACMode

20.103 N8 DPT_DHWMode

20.104 N8 DPT_LoadPriority

DPT ID DPT Format DPT Name
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20.105 N8 DPT_HVACContrMode

20.106 N8 DPT_HVACEmergMode

20.107 N8 DPT_ChangeoverMode

20.108 N8 DPT_ValveMode

20.109 N8 DPT_DamperMode

20.110 N8 DPT_HeaterMode

20.111 N8 DPT_FanMode

20.112 N8 DPT_MasterSlaveMode

20.113 N8 DPT_StatusRoomSetp

23.001 N2 DPT_OnOff_Action

23.002 N2 DPT_Alarm_Reaction

23.003 N2 DPT_UpDown_Action

23.102 N2 DPT_HVAC_PB_Action

DPT ID DPT Format DPT Name
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ATEN Control Box Reset Button

The reset button on ATEN Control Boxes can be used to reset system settings 

as described below.

Reset Button Functions

Control Box 

ON/OFF
Operation Description

ON Short press Resets the Control Box’s network 

settings.

Press and hold until the front 
panel LEDs blink once, with the 
buzzer beeping once (about 8 
seconds)

Resets all settings back to factory 
default (deleting all Viewers, 
Projects, and account/password) 
but retains the network and 
license settings.

OFF While pressing and holding, turn 
on the Control Box, and release 
when the buzzer beeps once, with 
the front panel LEDs blinking.

Enters Recovery Mode without 
resetting the Control Box’s 
settings.

While pressing and holding, turn 
on the Control Box, and release 
when the buzzer beeps twice, with 
the front panel LEDs blinking.

Resets all settings back to factory 
default but retains the license 
settings, and enters Recovery 
Mode.

While pressing and holding, turn 
on the Control Box, and release 
when the buzzer beeps 3 times, 
with the front panel LEDs blinking.

Resets all of the Control Box’s 
settings, including Viewers, 
Projects, account/password, 
network, and licenses.
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Windows OS Button Limitation

There is a limitation for overlapping buttons when adding buttons for a Viewer 

to be used on Windows mobile devices. When two or more buttons are layered 

on one another, such as (A) on top of (B), users are unable to press the top most 

button (A), and instead triggers the bottom button (B) every time trying to press 

(A). To resolve this issue, copy the top most button (A), and add the duplicate 

(C) under both (A) and (B) on the Viewer. 

When the top button (A) is pressed, the lowest button (C) is executed. 
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ATEN Standard Warranty Policy

Limited Hardware Warranty

ATEN warrants its hardware in the country of purchase against flaws in 

materials and workmanship for a Warranty Period of two [2] years (warranty 

period may vary in certain regions/countries) commencing on the date of 

original purchase. This warranty period includes the LCD panel of ATEN LCD 

KVM switches. Select products are warranted for an additional year (see A+ 

Warranty for further details). Cables and accessories are not covered by the 

Standard Warranty.

What is covered by the Limited Hardware Warranty

ATEN will provide a repair service, without charge, during the Warranty 

Period. If a product is detective, ATEN will, at its discretion, have the option 

to (1) repair said product with new or repaired components, or (2) replace the 

entire product with an identical product or with a similar product which fulfills 

the same function as the defective product. Replaced products assume the 

warranty of the original product for the remaining period or a period of 90 days, 

whichever is longer. When the products or components are replaced, the 

replacing articles shall become customer property and the replaced articles 

shall become the property of ATEN.

To learn more about our warranty policies, please visit our website:

http://www.aten.com/global/en/legal/policies/warranty-policy/
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